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TEACH YOURSELF VIA VISUAL LEARNING 
Visual learning is a teaching and learning style in which images, pictures or colours are used to gain 
information for studying. Visual learning forms part of the three basic learning styles which includes the 
Kinesthetic (learning that takes place via physical activity as opposed to listening or watching) and 
Auditory (learning that takes place via listening) learning styles. Generally visual learners also have a 
good sense of spatial awareness (sense of direction) and as imagery is used to visualize they also often 
like to draw and scribe. 
 
At LEARN NEW SKILLS FROM HOME, we strive to help self-study learners achieve their goals by 
providing affordable learning materials without compromising on quality.  All our study materials are 
designed for the VISUAL LEARNER and use easy-to-follow, step-by-step instructions, illustrated 
throughout via screen shots. This easy-to-use visual guide covers advanced features in popular Microsoft 
Office 2007 applications and incorporates FIVE UNITS IN ONE book, Word, Excel, Access, PowerPoint and 
ITQ Word.   Additional learning support supplied includes examination checks, shortcut tips, test 
structures and underpinning knowledge.  Learners will also have FREE access to our online Members’ 
Area (12 months access), which has additional question and answer snippets, job search facilities, 
qualification updates and a learner’s forum. 
 
The Advanced (level 3) units covered within this guide incorporate the globally recognised v.2.0 
syllabuses for the “European Computer Driving Licence” (ECDL), “International Computer Driving 
Licence” (ICDL) qualifications and the updated, nationally recognised syllabus for the “Information 
Technology Qualification” (ITQ) certification. 
 
 
 

UNITS COVERED WITHIN THIS GUIDE 

Units covered within this guide include some of the world’s most popular ICT (Information 
Communication Technology) applications, which utilise the Microsoft Office suite of programs.  
Applications covered: 
 
 Microsoft Word (Advanced Word-Processing) 
 Microsoft Excel (Advanced Spreadsheets) 
 Microsoft Access (Advanced Databases)  
 Microsoft PowerPoint (Advanced Presentations) 
 Microsoft Word (Advanced ITQ Word-Processing) 

 
 
 

ABOUT THE AUTHOR 

Paul Buggs is a certified Microsoft Office Master Instructor who has delivered ICT (Information 
Communication Technology) training materials for both private and public educational providers 
for over a decade.   
 
In 2009 Paul founded LEARN NEW SKILLS FROM HOME to help self-study learner's achieve their 
educational goals using quality study guides that incorporate both maximum learning flexibility and 
cost-effectiveness. 
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QUALIFICATION OVERVIEW 

The ECDL Foundation offers globally recognised ICT (Information Communication Technology) 
certifications, which many leading corporations/governments (IBM, IKEA, Ministry of Defence, Post 
Office, Bank of England, Shell and Pfizer) have adopted as their prerequisite ICT benchmark for 
employees.  The quality and reputation of the Foundation has been built on over a decade of 
experience in successfully delivering ICT certification to over 9 million people, in 41 languages, 
covering 148 countries around the world.  The ECDL (European Computer Driving Licence) 
qualification was established in 1997 and due to its success the ICDL (International Computer 
Driving Licence) was established shortly after in 1999 for the international market outside Europe.  
Both the ECDL and ICDL certifications are global recognised qualifications and have the same 
syllabus and test structures, the only difference being the ECDL is designated for European (ECDL) 
countries the ICDL for regions outside Europe.  Further information including qualification news 
and updates can be found on the ECDL Foundation website - www.ecdl.org 
 

 
 

ECDL (ICDL) ADVANCED MODULES 

ECDL Advanced (Word-Processing, Spreadsheets, Databases and Presentations) units/modules are 
set as level 3 (A-Level) qualifications in the UK by QCF (Qualifications and Credit Framework).  
Advanced units/modules are designed for learners who have intermediate/advanced skills in ICT 
and wish to gain a worldwide recognised certification. 
 
 

 

ECDL (ICDL) EXPERT 
 
Learners who successfully pass four ECDL Advanced units/modules can claim the “ECDL (ICDL) 
Expert” certification at no extra cost.  Further information can be found on the ECDL Expert  
website - www.ecdlexpert.co.uk 
 

  

http://www.bcsitq.co.uk/
http://www.ecdl.org/
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ITQ ADVANCED UNIT 

The ITQ (Information Technology Qualification) unit “Improving Productivity Using IT” was 
introduced in 2010 to allow learners (UK only) to use their ICT skills and knowledge to manipulate 
commonly used IT tools and improve their overall productivity. ITQ certifications consist of a 
portfolio of qualifications which replaced the NVQ "National Vocational Qualifications" for IT and 
computing units. ITQ is a UK nationally-recognised programme which has been designed by 
employers to meet the needs of today's businesses.  The ITQ Improving Productivity Using IT unit 
can be mapped to the ECDL portfolio and once added to four ECDL Advanced (level 3) modules 
enables learners to claim the “ITQ Level 3 in IT User Skills” certification provided by BCS (British 
Computer Society).  Candidates only need to successfully achieve one of three available (Word, Excel 
or PowerPoint) advanced scenario based assignments to gain the ITQ certification.  ITQ Advanced 
units can be completed by both manually and automated test methods.  Further information about 
ITQ Units can be found on the BCS/ITQ website - www.bcsitq.co.uk 
 

 

 

TESTING CENTRES 

ECDL (ICDL) Advanced examinations incur no registration fees but examinations cost approximately 
£70 per exam (prices may vary).  Candidate identification is required usually in the form of a utility 
bill and passport or driving licence.  Learners are advised to book their desired examination date 
10-14 days prior.  In September 2012, manual tests for ECDL Advanced units/modules were 
replaced with industry standard e-assessments.  E-assessments offer many advantages over manual 
tests, including instant results and a break-down of a candidate’s strengths and weaknesses. 
 
ITQ Advanced learners must register at their local testing centre (10-14 days recommended), prior 
to their first examination, identification is required usually in the form of a utility bill and passport 
or driving licence.  A one off administration fee may be incurred of approximately £50 - £70 (prices 
may vary).  For further information please contact your local testing centre. 
 
There are literary 1000's of ECDL Advanced, ICDL Advanced and ITQ Advanced test centres around 
the UK and 10,000’s globally.  Please visit the BCS website to find your nearest test centre - 
http://apps.bcs.org/fac/ 
 
 
 

SAMPLE TESTS 

Additional ECDL Advanced, ICDL Advanced and ITQ Advanced sample tests are available for FREE 
via the ECDL website: 
 
 
 

 

 

  

http://www.ecdl.org 

http://www.bcsitq.co.uk/
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BRITISH COMPUTER SOCIETY ASSOCIATE MEMBERSHIP 
(AMBCS) 
 
Learners who gain all four ECDL Advanced certifications can apply for “British Computer Society 
Associate Membership (AMBCS)”.  Associate Membership is aimed at those who are at the start of 
their career in IT and taking their first step on the ladder to full Professional membership.   Once 
approved, learners can use the letters AMBCS after their name on CV / resumes and business cards, 
enhancing their job/career prospects.  For further information please visit - www.bcs.org 
 

 

 

HOW TO USE THIS GUIDE 

This guide covers Advanced (level 3) features using popular Microsoft Office 2010 applications.  As 
this guide is set at level 3 (A-Level) it is aimed at learners who have some prior knowledge of the 
application/s they wish to study.  Learners can use this guide to complete individual or several 
(Word-Processing, Spreadsheets, Databases or PowerPoint) units/modules.  Learners who wish to 
complete all five units/modules can study them in any order enabling them to concentrate on areas 
of most importance first. 
 
 

 

SOFTWARE REQUIREMENTS 

ECDL and ITQ Units are non vendor-specific, which means examinations can be taken using a variety 
of software (Lotus Notes, Microsoft Office, OpenOffice etc…) packages.  For the purposes of this 
training guide we have selected the “Microsoft Office 2010 Suite”.  The Office 2010 suite of 
applications is predominately used within most companies globally and therefore enables learners 
to maximize their prospects in finding employment and enhancing their careers.  To complete the 
unit/modules within this guide learners will need access to a PC (preferably with Vista, Windows 7 
or Windows 8 operating system) and Microsoft Office 2010. 
 
Free 30 day trials of Microsoft Office 2010 can be downloaded via the Microsoft website at:  
 
 
 
 
 
 

UPDATES 

To reflect any syllabus, exam and guide updates we have supplied an updates page, where learners 
can access and download any recent changes: 
 
 
 

 

  

http://office.microsoft.com 

http://www.learn-new-skills-from-home.com/our-courses/resources/updates.html 
(Second Site) https://sites.google.com/site/learnnewskillsfromhome/updates 
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MARKING SCHEMES 

Once learners have completed their chosen application (Word, Excel, Access or PowerPoint) 
unit/module test, they will need to printout the relevant marking scheme which is located in the 
“Marking Scheme” folder (located in the downloaded files).  Learners can cross-reference their 
answers with the previously studied material within the guide.  The Marking Schemes are designed 
so learners can write in comments regarding their answers.  Some questions can be awarded half-
marks (except multiple-choice) if partially completed but it is best practice for learners to only mark 
completely correct answers as right, this is due to differing marking decisions and testing methods 
(manual and automated) used. 
 
 
 

DOWNLOADING REQUIRED WORK-FILES 

All required work-files for this training guide are supplied within the “Advanced” folder of the 
learners chosen application (Word, Excel, Access and PowerPoint) and are available for 24/7 
download at:  
 
 
 
 

 

 

 

MEMBERS’ AREA 
 

Additional learning support supplied within this guide includes examination checks, shortcut tips, test 
structures and underpinning knowledge.  Learners will also have access to our online “Members’ Area”, 
which has additional question and answer snippets, job search facilities, qualification updates and a 
learner’s forum.  Joining details are supplied at the back of this guide. 
 

 

 

KEY SYMBOLS 

 
 

 

Exam Checks 

 

Test Structure 

 

Shortcut Tips 

 

Underpinning Knowledge 

  

http://www.learn-new-skills-from-home.com/our-courses/resources/work-files.html 
(Second Site) https://sites.google.com/site/learnnewskillsfromhome/home 
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ADVANCED WORD-PROCESSING UNIT 

The Advanced Word-Processing Unit covers advanced features, shortcuts, 
examination checks and underpinning knowledge related to Microsoft Office Word 
2010 certifications.  The Advanced Word-Processing unit is designed to enable 
learners to complete complex tasks in a Word-Processor (Microsoft Word) 
application. Advanced tasks include, using sophisticated typographical, formatting 
and layout configurations, including tables, forms and graphics, master documents 
and using macros and advanced mail-merge operations.  

 
 
 

WORD 2010 LAYOUT 

Microsoft Office Word 2010 supports the “DOCX” (XML format), which was introduced in Word 
2007.  The DOCX format took over from the standard “DOC” format used in previous office (2000, 
XP, 2003) versions.  Microsoft Office 2010 is backwards compatible enabling earlier Word versions to 
be opened in Word 2010 but documents that were originally created in Word 2010 cannot be 
opened in older applications (excluding Office 2007), using the ‘DOC’ format unless a compatibility 
program is used (compatibility programs are available from Microsoft downloads website). Besides 
the new XML format Microsoft Office 2010 has many mor added features and cosmetic changes 
compared to Office 2003 including general functionality and toolbars.  
 
 
 

 
 

 
 

  

OFFICE BUTTON RIBBON TABS 

GROUPS 

NAVIGATION PANE 

ZOOM PAGE BAR 

The Word editor view is generally set as 
Print Layout as default. Print Layout is 
ideal for user to get the best perspective 
of how their document will be displayed 
when completed.  Page views can vary, 
depending on whichever view the user 
last edited (Full Screen Reading, Web 

Layout, Outline and Draft) and save the 
document in. 
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THE MICROSOFT OFFICE BUTTON 

Initially introduced in Word 2007 the Microsoft Office Button has had another makeover with the 
command options/buttons listed on the left whilst the list of previously opened documents appears on 
the right.  Additionally the Office Button style has be reverted back to previous versions (2000, 2003) 
using the text “File”.  The Office Button is located in the upper-left corner of the Word 2010 window, 
when the button is selected it displays a drop-down menu, which includes common menu options 
including New, Open, Save, Save As, Print and the Exit and Options buttons (for accessing 
additional commands). 
 
 
 
 

 
 

MENU OPTIONS 

OFFICE BUTTON 

COMMAND BUTTONS 

OPTIONS BUTTON 

Select the Alt + T + O keys to 
activate the Word Options 

dialog box. 
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RIBBON 
Microsoft Word 2010 unlike some previous versions (2000, 2003) uses a “Ribbon” interface to issue 
commands.  The Ribbon is located near the top of the window, below the “Quick Access Toolbar”.  
At the top of the Ribbon are several tabs; clicking a tab will display several related command groups.  
Within each group are linked command buttons.  Additionally a dialog box launcher is located in the 
bottom-right corner of several groups, clicking the dialog box launcher option will give access to 
extra commands.  It is advised that learners use the recommended (by Microsoft) 1024x768 or 
higher screen resolution when using Microsoft Office 2010; this is due to a dynamic ribbon being 
used which adjusts the amount of options displayed depending on visible space. 
 
 
 
 

 

 
 
 
 
 

QUICK ACCESS TOOLBAR 

The “Quick Access Toolbar” is located by default at the top of the Word window and provides quick 
access to tools that are used frequently. The Quick Access Toolbar can be customized by adding and 
removing commands to it. 
 
 
 
 

  

QUICK ACCESS TOOLBAR 

MORE COMMANDS OPTION 

Before starting any test questions 
learners should make sure the 

“Minimize the Ribbon” option is 
deselected on the quick access 

toolbar otherwise the Office 
Ribbon will be minimized every 
time you click on the document 

page.  Select the Ctrl +F1 keys to 
activate the Ribbon option. 

COMMAND BUTTONS/OPTIONS 

DIALOG BOX LAUNCHER 

QUICK ACCESS TOOLBAR 

RIBBON TAB 
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SYLLABUS AREAS COVERED 

Due to the new ECDL (ICDL) Advanced syllabus version 2.0 overhaul, the four Advanced ECDL and 
ICDL modules (Word-Processing, Spreadsheets, Databases and Presentations) have been updated, 
making the questions more relevant for modern day usage.  The marking structure for the new ECDL 
(ICDL) Advanced syllabus v2.0 is still the same as in the previous v1.0 syllabus with 20 questions a 
required pass mark of 15 out of 20 (75%) and 1 hour time limit.  The full v2.0 syllabus can be 
downloaded via the ECDL website – www.ecdl.org   
 

 
 UNDERPINNING KNOWLEDGE 
 MAIL-MERGE 
 BOOKMARKS 
 IMAGE MANIPULATION 
 TEXT FORMATTING 
 MACROS 
 PARAGRAPH SPACING 
 CHARACTER STYLES 
 WATERMARKS 
 FOOTNOTES 
 DOCUMENT SECURITY 
 FILESIZE FIELDS 
 DROP-DOWN LIST FIELDS 
 CHECK BOX FIELDS 
 TABLE PROPERTIES 
 CAPTIONS 
 MASTER DOCUMENTS 
 INDENT AND SPACING 
 LINK AND EMBED EXTERNAL DATA VIA MICROSOFT EXCEL 
 TRACK CHANGES 
 PAGE SETUP 
 DELETE SECTION BREAKS 
 MARK INDEX 
 TABLE OF CONTENTS 
 MODIFY TEMPLATE 
 DELETE/ADD AUTOMATIC TEXT ENTRIES 

 
  

It is advisable learners who wish to take 
just the Advanced Word-Processing 

examination also work through the 
Advanced ITQ Word-Processing Unit 

for additional practice. 
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ADVANCED WORD-PROCESSING 2010 GUIDE 

The following guide covers advanced features, shortcuts, examination checks and underpinning 
knowledge related to Microsoft Office Word 2010 certifications.  Once you have worked your way 
through the guide and are satisfied that you understand the information provided attempt the 
Advanced Word-Processing tests located at the end of this unit. 
 
 
 

UNDERPINNING KNOWLEDGE 

Although predominately Word examinations don’t have multiple-choice questions it is advisable to 
study the following underpinning knowledge, as it will help reinforce application knowledge.  

 

  

 

WORD-PROCESSOR 
 
A word-processor is an electronic device or computer software application that can create (by 
the user), edit, format and print written material. 
 

 
MICROSOFT WORD 
 
Word is a graphical word-processing program that users can add styles to text, add captions 
to images and text, cross references (headings and figures), add comments to text and images, 
track changes, embed objects and auto-generate tables and indexes.  Word is used primarily 
for creating documents such as letters, brochures, learning activities, tests and quizzes.  
 
 

HISTORY 
 
Word was first released in 1981 with many of the ideas and features incorporated into it 
coming from Bravo, the first graphical writing program.  Microsoft brought the Bravo 
program, and changed its name to Microsoft Word.   When Word was released it used a 
feature called WYSIWYG (What You See Is What You Get), which meant that users could 
change the visual style of writing (e.g. bold, italics), by clicking on buttons, when in other 
programs like WordPerfect, users had to add special 'codes' to change the style of writing. 
WYSIWYG is now a common feature of all computer writing programs. 
 
 

FILE FORMATS 
 
Word 2007, 2010 and 2013 versions support the “DOCX” (XML format).  The DOCX 
format took over from the standard “DOC” format used in previous office (2000, XP, 
2003) versions.   
 

http://simple.wikipedia.org/wiki/1981
http://simple.wikipedia.org/w/index.php?title=Graphical&action=edit&redlink=1
http://simple.wikipedia.org/w/index.php?title=Bravo&action=edit&redlink=1
http://simple.wikipedia.org/wiki/WYSIWYG
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WORD EXTENSIONS 
 

XML FILE TYPE EXTENSION 

Document .docx 

Macro-enabled document .docm 

Template .dotx 

Macro-enabled template .dotm 

 

 

WORD TEMPLATES 
 
A template is a document type that creates a copy of itself when the user opens it.. In 
Microsoft Office Word users can create a template saving a document as a .dotx file, .dot file, 
or a .dotm file (a .dotm file type allows you to enable macros in the file).   
 

 
CROSS-VERSION COMPATIBILITY 
  

As with all application types if Word is opened in a version (2000, 2003, 2007, 2010, 2013 
etc…), other than the edition it was created in, can cause an incorrect display of the document. 
The document formats of the various versions can change in subtle and not so subtle ways 
(including fonts, footnotes etc…).  Word formatting created in newer versions does not always 
survive when viewed in older versions of the program, nearly always because that capability 
does not exist in the previous version.  Rich Text Format (RTF), an early effort to create a 
format for interchanging formatted text between applications, is an optional format for Word 
that retains most formatting and all content of the original document. 
 
 

IMAGE TYPES 
 
Users can insert many popular graphics file formats into their document either directly or 
with the use of separate graphics filters. Compatible file types include:  Enhanced Metafile 
(.emf), Graphics Interchange Format (.gif), Joint Photographic Experts Group (.jpg), Portable 
Network Graphics (.png), Microsoft Windows Bitmap (.bmp, .rle, .dib), Windows Metafile 
Graphics (.wmf) and Tagged Image File Format (.TIFF). 
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SHORTCUTS 
 

KEY GENERAL 

ALT+TAB Switch to the next window. 

ALT+SHIFT+TAB Switch to the previous window. 

CTRL+W or CTRL+F4 Close the active window. 

ALT+F5 Restore the size of the active window after you maximize 
it. 

SHIFT+F6 Move to a task pane from another pane in the program 
window (counterclockwise direction). 

CTRL+F6 When more than one window is open, switch to the next 
window. 

CTRL+SHIFT+F6 Switch to the previous window. 

CTRL+F10 Maximize or restore a selected window. 

ALT+PRINT SCREEN Copy a picture of the selected window to the Clipboard. 

CTRL+SHIFT+SPACEBAR Create a nonbreaking space. 

CTRL+SHIFT+HYPHEN Create a nonbreaking hyphen. 

CTRL+B Make letters bold. 

CTRL+I Make letters italic. 

CTRL+U Make letters underline. 

CTRL+SPACEBAR Remove paragraph or character formatting. 

CTRL+C Copy the selected text or object. 

CTRL+V Paste text or an object. 

CTRL+ALT+V Paste special 

CTRL+SHIFT+V Paste formatting only 

CTRL+Z Undo the last action. 

CTRL+Y Redo the last action. 
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KEY PRINT AND PREVIEW DOCUMENTS 

CTRL+P Print a document. 

ALT+CTRL+I Switch to print preview. 

Arrow keys Move around the preview page when zoomed in. 

PAGE UP or PAGE DOWN Move by one preview page when zoomed out. 

CTRL+HOME Move to the first preview page when zoomed out. 

CTRL+END Move to the last preview page when zoomed out. 

 
 

KEY REVIEW DOCUMENTS 

ALT+CTRL+M Insert a comment. 

CTRL+SHIFT+E Turn change tracking on or off. 

ALT+SHIFT+C Close the Reviewing Pane if it is open. 

 
 

KEY OUTLINE VIEW 

ALT+SHIFT+LEFT ARROW Promote a paragraph. 

ALT+SHIFT+RIGHT ARROW Demote a paragraph. 

CTRL+SHIFT+N Demote to body text. 

ALT+SHIFT+UP ARROW Move selected paragraphs up. 

ALT+SHIFT+DOWN ARROW Move selected paragraphs down. 

ALT+SHIFT+A Expand or collapse all text or headings. 

ALT+SHIFT+L Show the first line off body text or all body text. 

ALT+SHIFT+1 Show all headings with the Heading 1 style. 

ALT+SHIFT+n Show all headings up to Heading n. 

CTRL+TAB Insert a tab character. 
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DOCUMENT SECURITY 

 
Select and open the Survey document located within the Advanced Word-Processing folder 
by double clicking it.  

 
 
 

 
 
 
 
 
 

The Survey document will automatically open in Word. 
 
 
 
 
 

 
  

SURVEY DOCUMENT 

SURVEY DOCUMENT  

Double clicking 
documents will open 
them automatically in 

Word.  

If the Document opens in another application 
(Lotus Notes, OpenOffice etc…) then you may not 

have Word set as your default Word-Processor 
(right click the document and select the Open 

With, Microsoft Office Word options.) software.  
Alternatively Microsoft Office Word may not be 

installed on your machine.  Free 30-60 day trials 
are available for download at:  

 

http://office.microsoft.com 
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Select the Save As option from the Office Button. 
 
 
 
 

 
 
 
 

The Save As box will be displayed.  Select the Tools, General Options located at the bottom 
right corner of the Save As box. 

 
 
 

 
 
 
 

The General Options box will be displayed.  Enter the password “ecdl-icdl” (without quotes) 
into the Password to open: box (it will be displayed in security format).  Select the OK 
button. 

 
 
 

 
  

GENERAL OPTIONS BOX 

TOOLS OPTION 

GENERAL OPTION 

PASSWORD TO OPEN: BOX 

SAVE AS OPTION 

OFFICE BUTTON 

Select the F12 function 
key to activate the Save 

As function. 

SECURITY FORMAT 
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The Confirm Password box will be displayed.  Retype the password (ecdl-icdl) in the 
Reenter password to open: box.  Select the OK button. 

 
 
 
 

 
 
 
 

Save the Survey document in its original location (Advanced Word-Processing folder) with 
its original name (Survey), by selecting the Save button. 

 
 

 

 
 
 
 
 
 
 
 
 
 
 
 

TRACK CHANGES 

 
Open the self-study document located in the Advanced Word-Processing folder by double 
clicking it. 

 
 
 
 

 
 
 
 
 
  

SELF-STUDY DOCUMENT 
Double clicking 

documents will open 
them automatically in 

Word. 

REENTER PASSWORD TO OPEN BOX 

It is advisable to close then 
reopen the Survey document 

to test the recently added 
password. 

 

CONFIRM PASSWORD BOX 
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Select the Review tab located on the ribbon. 
 
 
 

 
 
 
 

Select the Track Changes button within the Tracking group. 
 
 
 
 

 
 
 
 
 
 

 
 
 
 
 
 

Right click the misspelled text “tutory” within the document.  A submenu will be displayed with 
spelling suggestions, select the “tutors” option from the submenu. 

 
 
 

 
 
 
 

The spelling correction will be displayed with the original text. 
 
 
 

 
  

REVIEW TAB 

TRACKING GROUP 

TRACK CHANGES BUTTON 

The Track Changes option allows users to track changes made to a 
document, including deletions, formatting and insertions.  

To activate the Track 
Changes option, select 

the Ctrl + Shift + E 
keys. 

TUTORS OPTION 

ORIGINAL AND CHANGED TEXT 

SUBMENU 
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 Select the text “learning” within the document by highlighting it. 
 
 
 

  
 
 
 

With the text still highlighted type the text “studies”.  The amended text will be displayed 
alongside the original text. 

 
 
 

 
 
 
 

Select the Office Button, Save options. 
 
 
 
 

 
 
 
 
  Select the Office Button, Close options. 
 
 
 

  

HIGHLIGHTED TEXT 

ORIGINAL AND CHANGED TEXT 

SAVE OPTION 

OFFICE BUTTON 

Select the Ctrl + S 
keys to activate the 

Save option. 

CLOSE OPTION 

OFFICE BUTTON 

Select the Alt + Spacebar then 
select the C key to activate the 

Close option. 
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DELETE SECTION BREAKS 

 
Open the Independent Study document located in the Advanced Word-Processing folder 
by double clicking it. 

 
 
 

 
 
 
 
 
 
 
 Select the Home tab (if required) located on the ribbon. 
 
 
 

 
 
 
 
 Select the Show/Hide option within the Paragraph group. 
 
 
 

 
 
 
 
 
 
 
 
 
 

The section break on the first page will be displayed. 
 
 
 

  

Double clicking 
documents will open 
them automatically in 

Word. 

Select the Ctrl + * keys to 
activate the Show/Hide 

option. 

HOME TAB 

PARAGRAPH GROUP 

SHOW/HIDE OPTION 

SECTION BREAK 

The Show/Hide option displays the documents Paragraph Marks and other hidden formatting 
symbols.  Unless deactivated the paragraph marks will be displayed when the document is saved 

or subsequent documents are opened within the current Word session. 

INDEPENDENT STUDY DOCUMENT 
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Select just prior to the displayed Section Break and select the Delete key located on the 
keyboard. 

 
 
 
 
 
 
 

 
 
 
 
 

The Section Break will be deleted and text previous on page 2 of the document will be 
displayed on the first page of the file. 

 
 
 

 
 

 
 
 
 
 
 

Select the Save option located on the Quick Access Toolbar. 
 
 
 
 

 

 

 
  

SELECTION POINT 

TEXT FROM PAGE 2 

Paragraph Marks will not be displayed when a document is 
printed.  Once a question criteria is complete it is advisable 

to turn off paragraph marks by selecting the Show/Hide 
option previous shown (this is due to Paragraph Marks 

obscuring subsequent document alignments, which may cost 
candidates precious editing time). 

A Next Page Section Break starts a 
new section on the next page of the 
document, whereas a Continuous 

Section Break starts a new section on 
the same page. 

SAVE OPTION 
Select the Ctrl + S keys 

to activate the Save 
option. 

QUICK ACCESS TOOLBAR 
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PAGE SETUP 

 
Open the Independent Study document (if required) located in the Advanced Word-
Processing folder by double clicking it.  Select the Page Layout tab located on the ribbon. 

 
 
 

 
 
 
 
 Select the Orientation drop-down option located within the Page Setup group. 
 
 
 
 
 

 
 
 
 
 Select the Landscape option from the drop-down menu. 
 
 
 

 
 
 
 
 
 

The page orientation has now changed to Landscape. 
 
 
 

  

PAGE LAYOUT TAB 

PAGE SETUP GROUP 

ORIENTATION DROP-DOWN OPTION 

LANDSCAPE OPTION 

LANDSCAPE ORIENTATION AMENDED LINE ENDINGS 

The new page orientation will 
affect the documents layout (line 
endings, images etc…) this is part 

of the built-in format and no 
amendments are required, unless 

stated within the question 
criteria. 
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Select the Office Button, Save options. 
 
 
 

 
 
 
 
  Select the Office Button, Close options. 
 
 
 
 

 
 
 
 

WATERMARKS 

 
Open the Plans document located in the Advanced Word-Processing folder by double 
clicking it. 

 
 
 

 
 
 
  

PLANS DOCUMENT 
Double clicking 

documents will open 
them automatically in 

Word. 

SAVE OPTION 

OFFICE BUTTON 

Select the Ctrl + S 
keys to activate the 

Save option. 

CLOSE OPTION 

OFFICE BUTTON 

Select the Alt + Spacebar then 
select the C key to activate the 

Close option. 
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The Plans document will automatically open in Word. 
 
 
 

 
 
 
 

Select the Page Layout tab located on the ribbon. 
 
 
 

 
 
 
 

Select the Watermark drop-down option within the Page Background group. 
 
 
 

 
 
 
 
 

A drop-down menu will be displayed, select the Custom Watermark option. 
 
 
 
 

 
 
 
  

PAGE BACKGROUND GROUP 
WATERMARK DROP-DOWN OPTION 

CUSTOM WATERMARK OPTION 

PLANS DOCUMENT 

PAGE LAYOUT TAB 

Watermarks are generally set as semi-
transparent allowing inserted objects (text and 

graphics) printed over a Watermark to be 
clearly visible. 
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The Printed Watermark box will be displayed.  Select the Text watermark radio button.  
Select the SAMPLE option from the Text: drop-down list.  Ensure the Semitransparent 
check box is selected (usually set as default), select the Apply and Close buttons. 

 
 
 
 
 

 
 
 
 
 

The SAMPLE watermark will be displayed in semi-transparent form within the document. 
 
 
 

 
 
  

TEXT WATERMARK RADIO BUTTON 

PRINTED WATERMARK BOX 

SAMPLE OPTION 

SAMPLE WATERMARK 

SEMITRANSPARENT CHECK BOX 

Once the Apply button has 
been activated the Cancel 

button will be replaced 
with the Close button.  

Alternatively candidates 
can select the OK button 
which will automatically 
add the Watermark and 

close the Printed 
Watermark box. 

Watermarks will appear 
on each existing and newly 

created pages within the 
document. 
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Select the Office Button, Save options. 
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SAVE OPTION 

OFFICE BUTTON 

Select the Ctrl + S 
keys to activate the 

Save option. 

http://www.amazon.co.uk/Paul-Buggs/e/B00CZET1BI/ref=sr_ntt_srch_lnk_1?qid=1392239244&sr=1-1
http://www.lulu.com/spotlight/Teach_Yourself_Guides


© www.learn-new-skills-from-home.com 34 

 

TEACH YOURSELF GUIDES 

 

  

2007 Version (Third Edition) 
Paperback - £19.99 
eBook PDF - £9.99 

 

2010 Version (Third Edition) 
Paperback - £19.99 
eBook PDF - £9.99 

 
 

 
 

2013 Version (Third Edition) 
Paperback - £19.99 
eBook PDF - £9.99 

 


